




NoiseMaster 2.01 Help

NoiseMaster 2.01 is a shareware multi-window sample editor for Windows 3.1 from New
Noise. It supports the MS-Windows Wave format (.WAV), the Creative Labs Voice 
format (.VOC) and raw sample files.

Commands
File Menu
Edit Menu
Effects Menu
Transform Menu
Window Menu
Toolbar Commands

Procedures
Making a selection
Modifying a selection
Zooming
Placing the Paste Marker
Editing individual channels of a stereo sample

Registering NoiseMaster 2.0
Thanks and greetings



File Menu

In the File Menu you find the commands for opening and saving samples and for 
quitting NoiseMaster. It also contains the Options and the Wave Device Selection items.

New
Open
ReOpen
Save
Save As

Options
Select Wave Devices

Exit

Contents



New

Opens a new, empty sample window. The title of this new window is "UNTITLED.WAV".  
There are two reasons you might want to open a new sample window. 
The first and probably the most important is for recording new samples. To do this select
File | New and make sure the new, empty sample window is active. Then press the 
record button on the toolbar (this is the one with the red circle on it).
The second reason for opening an empty window is pasting part of another sample. 
Make a selection from one of the other open sample windows and select Cut or Copy. 
Then open a new
window (select File | New) and choose Paste Insert. You can also select Paste 
Overwrite or Paste Mix, but in this case they perform the same function as Paste Insert.

Selecting Save when a new, untitled window is active will perform a Save As, because 
the new sample has no filename yet.

File Menu
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Open

Selecting File | Open will display the standard File Open dialog box. Select the sample 
you want to open and press Ok. The selected sample is then opened in a new sample 
window. When you have selected a Windows Wave file (.WAV) or a Creative Voice file 
(.VOC), NoiseMaster extracts the file type from the sample header. When opening a file 
with another extension, NoiseMaster assumes it is a raw sample and asks you to 
specify the sample type in the Raw Sample type dialog box. See Opening Raw samples
for more details.
After opening a sample the status bar shows its sample type and size.

File Menu
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Opening Raw samples

When you select a sample in the Open file box, that has an extension other than .WAV 
or .VOC, NoiseMaster assumes it is a raw sample and asks you about the sample type 
in the Raw Sample type dialog box. This dialog box is show below. Just click on the 
different parts of this picture to get info about that part.

Each time you open a raw sample, NoiseMaster makes the sample type you select the 
default raw sample type. So the next time you open a raw sample, these values are 
already filled in. 
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Is it mono or stereo ?



Is it 8 bits or 16 bits ?



Is it signed or unsigned ?



Select the sample rate of the raw sample here.



Ok !!



ReOpen

ReOpen serves mostly as an Undo function. If you have edited a sample and you want 
to undo your modifications, select ReOpen from the File menu or press the ReOpen 
button on the toolbar. The sample in the active sample window is then reloaded from 
the sample file. But first you are given a chance to save your changes. If you ReOpen a 
raw sample, you are again presented with the Raw Sample type dialog box to specify 
the sample type.
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Save

Selecting Save saves the sample in the active sample window using the existing 
filename. If you try to Save a new, untitled sample (after recording or pasting in a new, 
empty window), NoiseMaster automatically performs a Save As and lets you specify a 
filename.
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Save As

Save As lets you save a sample using a new filename or even in another sample 
format. Just specify the new filename in the standard Save File dialog box. If you 
specify an extension other then the original extension (e.g. .VOC while the original 
was .WAV) the sample is automatically converted to the new format.

File Menu
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Options

Selecting Options will pop up the Options dialog box. In this box you can select some 
global settings of NoiseMaster 2.01. These settings are saved in the .INI when you exit 
NoiseMaster.

Click on the items in the picture of the Options Dialog below to see what they mean.
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This option affects the way the sample is displayed on screen :
Connected Lines : Sample values are connected by straight lines.
Vertical Lines : Sample values are shown as vertical lines from the zero 

line.
Dots : Sample values are shown as dots.



This option selects the unit of measure in which the positions in the sample will be 
displayed (for example in the selection field on the status bar).
Seconds : Positions are displayed in seconds, with a precision of 1/100 second.
Samples : Positions are shown in samples. This will give you a more precise 
indication of the marker positions.
Bytes : Position are shown in bytes. Use this get an indication of the size of 
selections.



If this checkbox is checked moving the samplerate scrollbar plays the sample. If this 
annoys you, just uncheck this option. I also recommend unchecking it if you are using 
the PC-speaker wave device driver.



By convention 8 bits samples are unsigned and 16 bits samples are signed. So when 
converting between 8 and 16 bits formats it is useful to automatically convert between 
unsigned and signed. Therefore the default of this option is ON. But raw samples 
sometimes have other conventions (such as Amiga samples). In these cases you might 
uncheck this option.



Select Wave Devices

This menu item opens the Select Wave Devices dialog which is show below. If you have
installed more than one wave output devices and/or more than one wave input devices, 
you can use this dialog to select the one you want to use with NoiseMaster. 
This dialog also shows the capabilities of the currently selected wave devices. The 
device capabilities are shown for the four possible sample types : 8-bit mono, 8-bit 
stereo, 16-bit mono and 16-bit stereo. For each type the checkboxes show if the device 
supports that type for the three standard sample rates 11025 Hz, 22050 Hz and 44100 
Hz.

Click on the items in the picture below for a short explanation of their functions.
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Select the wave device you want to use for sample output (playing). The list shows all 
wave output devices you have installed on your system.



Select the wave device you want to use for sample input (recording). The list shows all 
wave input devices you have installed on your system.



This area shows the device capabilities of the currently selected wave output device.



This area shows the device capabilities of the currently selected wave input device.



Exit

Use this menu item to exit NoiseMaster. Before exitting, NoiseMaster closes all open 
sample windows. For each sample that is modified and not yet saved, you are given the
chance to save it first.
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Contents



Edit Menu

In the Edit menu you find commands for cutting and pasting, deleting and trimming 
sample selections. All commands from the Edit menu are also available as buttons on 
the toolbar.

Cut
Copy
Paste Insert
Paste Overwrite
Paste Mix
Delete
Trim

Edit Menu
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Cut

The Cut command removes the selected block from the sample and copies it to the 
internal clipboard. So before using Cut you must always make a selection first. 
The clipboard contents can be copied back to the same sample or even another sample
with one of the paste commands : Paste Insert, Paste Overwrite and Paste Mix.

Tip : After you use the Cut command NoiseMaster automatically places the Paste 
Marker at the cut position. This makes it possible to quickly undo your Cut action by 
doing a Paste Insert.

Edit Menu
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Copy

The Copy command copies the selected block from the sample to the internal clipboard.
So before using Copy you must always make a selection first. 
The clipboard contents can be copied back to the same sample or even another sample
with one of the paste commands : Paste Insert, Paste Overwrite and Paste Mix.

Edit Menu
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Paste Insert

The Paste Insert command inserts the clipboard contents into the currently active 
sample at the paste marker. So before using Paste Insert you must always first place 
the paste marker at the position you want the clipboard contents to be inserted.

Pasting is only possible if the sample type of the clipboard contents matches the type of 
the sample in the currently active sample window. So they must have the same number 
of channels, the same number of bits, the same sign and the same samplerate. If they 
don't match NoiseMaster will tell you so and abort the paste operation.
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Paste Overwrite

The Paste Overwrite command overwrites the currently active sample with the clipboard
contents, starting at the paste marker. So before using Paste Overwrite you must 
always first place the paste marker at the position you want the clipboard contents to be
written.

Pasting is only possible if the sample type of the clipboard contents matches the type of 
the sample in the currently active sample window. So they must have the same number 
of channels, the same number of bits, the same sign and the same samplerate. If they 
don't match, NoiseMaster will tell you so and abort the paste operation.
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Paste Mix

The Paste Mix command mixes the clipboard contents into the currently active sample 
starting at the paste marker. So before using Paste Mix you must always first place the 
paste marker at the position you want the clipboard contents to be mixed in.

Pasting is only possible if the sample type of the clipboard contents matches the type of 
the sample in the currently active sample window. So they must have the same number 
of channels, the same number of bits, the same sign and the same samplerate. If they 
don't match NoiseMaster will tell you so and abort the paste operation.
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Delete

The result on the sample of the Delete command is exactly the same as the Cut 
command. The selected block is removed from the sample. But the Delete command 
does not copy this block to the internal clipboard. So if you want to remove a part of a 
sample and you do not need to paste this part later, use the Delete command instead of
the Cut command. This can save you a lot of memory.
Before using Delete you must always make a selection first. 
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Trim

The Trim command does exactly the opposite of the Delete command. It removes all but
the selected block of the sample, that is the part to the left of the selection and the part 
to the right of the selection. This results in a sample consisting only of the selected 
block. This can be useful, for example, for cutting silence parts from the beginning and 
end of voice recordings or for trimming a good loop from a music sample.
Before using Trim you must always make a selection first.
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Effects Menu

All command in the effects menu operate on the selected block of the currently active 
sample. So before selecting a command from this menu, always make a selection first. 
If you want the command to operate on the entire sample, just double click in the 
sample window to select it entirely. If there is no selection, these functions will have no 
effect (or these effects will have no function).

Reverse
Invert
Change Offset
Repeat
Swap Channels

Mute
Change Volume
Maximize Volume
Fade In
Fade Out

Echo
Reverse Echo

Contents



Reverse

The Reverse command reverses the selected block of the sample. So that part of the 
sample will be played backwards.

(This effect needs a selection to be effective !)

Effects Menu
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Invert

The Invert command inverts the signal values of the selected block of the sample. On 
screen this results in flipping the sample vertically. To hear the effect of this, try taking a 
mono sample, converting it to a stereo sample and inverting one of the channels of this 
stereo sample.

(This effect needs a selection to be effective !)

Mono <-> Stereo
Editing individual channels of a stereo sample
Effects Menu
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Change Offset

The recorded samples of some soundcards sometimes seem to float above or below 
the zero line, that is the sample offset is not exactly zero. If you encounter this problem 
you can correct the offset with the Change Offset command. This command needs one 
parameter, the offset increment or decrement. This parameter is set using the scrollbar 
in the Change Offset dialog box.
Note that the effect of the Change Offset command will not always be visible in the 
sample display, due to the limited vertical resolution of the sample windows, especially 
with 16 bits samples.

(This effect needs a selection to be effective !)

Effects Menu
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Repeat

The Repeat command repeats the selected block of the sample for a user specified 
number of times. It needs one parameter, the repeat count, which is selected with a 
scrollbar in the Repeat dialog box.
Since this command changes the length of the sample it cannot be used on a single 
channel of a stereo sample.

(This effect needs a selection to be effective !)

Effects Menu
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Swap Channels

The Swap Channels command exchanges the two channels in the selected block of the 
sample. So the left channel becomes the right channel and vice versa.
As you might have guessed, this command only works on stereo samples.

(This effect needs a selection to be effective !)

Effects Menu
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Mute

The Mute command reduces the signal in the selected block of the sample to zero. This 
silences that part of the sample. This command is the same as a Change Volume with a
scale value of 0%.

(This effect needs a selection to be effective !)

Effects Menu
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Change Volume

The Change Volume command lets you modify the amplitude of the signal in the 
selected block of the sample. You can amplify a sound or make it softer. This command 
needs one parameter, the scale value, which is a percentage between 0% and 1000%. 
A scale value of 0% mutes the sample, a scale value of 1000% amplifies it 10 times. 
The scale value is selectable in the Change Volume dialog box. High scale values will 
result in clipping of the signal values.

(This effect needs a selection to be effective !)

Effects Menu
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Maximize Volume

The Maximize Volume command increases the amplitude of the selected block of the 
sample maximally, without being clipped. This command generally increases the sound 
quality of your sample, but beware that Maximize Volume also increases the amplitude 
of possible background noise in your sample.

(This effect needs a selection to be effective !)

Effects Menu
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Fade In

The Fade In command adds a fade in effect to the selected block of the sample. This is 
like Change Volume, but now the scale value increases from 0% at the start of the 
selection to 100% at the end of the selection.

(This effect needs a selection to be effective !)

Effects Menu
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Fade Out

The Fade Out command adds a fade out effect to the selected block of the sample. This
is like Change Volume, but now the scale value decreases from 100% at the start of the 
selection to 0% at the end of the selection.

(This effect needs a selection to be effective !)

Effects Menu
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Echo

The Echo command adds an echo to the sample. It needs two parameters : the delay 
value and the gain value. The delay value specifies the delay in milliseconds between 
two echoes. The gain value specifies the decrease in volume of consecutive echoes. 
These two values can be set in the Echo dialog box.
Only the selected block of the sample produces an echo, but the echo will have its 
effect on the range of the sample right after the selection. If your selection is at (or near)
the end of the sample, this after echoing will make the sample longer, especially when 
using high delay and gain values.
Since this command may change the length of the sample it cannot be used on a single 
channel of a stereo sample.

(This effect needs a selection to be effective !)

Effects Menu
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Reverse Echo

The Reverse Echo command adds a reverse echo to the sample. A reverse echo is like 
an echo, but instead of adding echoes decreasing in volume after each sound, it adds 
echoes increasing in volume before a sound. 
It needs two parameters : the delay value and the gain value. The delay value specifies 
the delay in milliseconds between two echoes. The gain value specifies the decrease in 
volume of consecutive echoes. These two values can be set in the Echo dialog box.
Only the selected block of the sample produces an echo, but the echo will have its 
effect on the range of the sample right before the selection. If your selection is at (or 
near) the beginning of the sample, this after echoing will make the sample longer, 
especially when using high delay and gain values.
Since this command may change the length of the sample it cannot be used on a single 
channel of a stereo sample.

(This effect needs a selection to be effective !)

Effects Menu
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Transform Menu

All commands in the Transform Menu change the sample type of the currently active 
sample. This is why these commands always operate on the entire sample. You don't 
have to make a selection first.

Mono <-> Stereo
8 bits <-> 16 bits
Signed <-> Unsigned
Resample
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Mono <-> Stereo

The Mono <-> Stereo command converts samples from mono to stereo and vice versa. 
Converting from mono to stereo simply duplicates the mono signal to both the left and 
right channels. Converting from stereo to mono takes the average of the left and right 
channels as the mono signal.

Transform Menu
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8 bits <-> 16 bits

The 8 bits <-> 16 bits command converts 8 bits samples to 16 bits samples and vice 
versa. Note that converting from 16 bits to 8 bits results in loss of resolution.
By convention 8 bits samples are unsigned and 16 bits samples are signed. So when 
converting between 8 and 16 bits formats it is useful to automatically convert between 
unsigned and signed. Normally NoiseMaster does this automatically. You can switch off 
this automatic sign conversion in the Options dialog.

Transform Menu
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Signed <-> Unsigned

The Signed <-> Unsigned command converts signed samples to unsigned samples and
vice versa. 
By convention 8 bits samples are unsigned and 16 bits samples are signed. Note that if 
your sample doesn't follow this convention and you try to play it, the windows wave 
output device will only produce noise.

Transform Menu
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Resample

The Resample commands changes the samplerate of the currently active sample by 
resampling. This is not the same as moving the samplerate scrollbar on the toolbar. 
Resampling changes the samplerate without changing the speed of the sample. It adds 
bytes to or removes bytes from the sample to do this. 

Transform Menu
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Window Menu

The Window Menu contains commands for managing the sample windows. It also 
shows the names of all open sample windows. Selecting one of them activates the 
specified window.

Tile
Cascade
Arrange Icons
Close All
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Tile

The Tile command tiles all the sample windows within the frame of NoiseMaster 2.0.

Window Menu
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Cascade

The Cascade command cascades all sample windows within the frame of NoiseMaster 
2.0.

Window Menu
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Arrange Icons

The Arrange Icons command arranges the icons of minimized sample windows.

Window Menu
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Close All

The Close All command closes all sample windows.    For each sample that is modified 
and not yet saved, you are given the chance to save it first.

Window Menu
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Toolbar Commands

The toolbar contains the buttons for sample playback and recording and it provides 
quick acces to some often used commands.

Just click on that part of the toolbar you want information about.

Contents



Play

Pressing the Play button plays the currently active sample from the beginning. If the 
Loop checkmark is checked it will be played in a loop. Press Stop to stop playing and 
Pause to temporarily pause the playback.
If you press Play to play a sample and nothing happens, make sure your wave output 
device is capable of playing that sample type. You can check this using the Select Wave
Devices command in the File Menu.

Toolbar Commands
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Play Selection

Pressing the Play button plays the selected block of the currently active sample. If the 
Loop checkmark is checked it will be played in a loop. Press Stop to stop playing and 
Pause to temporarily pause the playback.
If you press Play Selection to play part of a sample and nothing happens, make sure 
your wave output device is capable of playing that sample type. You can check this 
using the Select Wave Devices command in the File Menu.

Toolbar Commands
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Stop

Pressing the Stop button stops the playback of a sample or stops recording.

Toolbar Commands
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Pause

The Pause button temporarily pauses playback of a sample. Playback can be restarted 
by pressing the Pause button again or by pressing the Play button. 
The Pause button cannot be used to pause during recording.

Toolbar Commands
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Record

Using Record you record your own samples. After you press the Record button the 
Record dialog box will appear. In this dialog box you can specify the sample type and 
size of the sample you want to record. Click on the items in the picture below to see 
what they do.

If you specify a sample type your wave input device doesn't support or a recording 
length larger than the maximum length, the Ok button will be disabled. In this case, 
change your selections or press Cancel to stop.

Toolbar Commands
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Specify the samplerate you want to use. If you specify a samplerate the currently 
selected wave input device doesn't support, the Ok button will be disabled.



Mono or stereo ? If you specify stereo and your wave input device does not support 
stereo, the Ok button will be disabled.



8 bits or 16 bits ? If you specify 16 bits while your wave input device does not support 
16 bits recordings, the Ok button will be disabled.



Enter the length in seconds of the recording. Make sure you specify a length less than 
the Max Length show below. If you enter a length larger than the maximum length, the 
Ok button will be disabled.



This field shows the maximum recording length you can use. This values depends on 
the amount of physical memory you have left.



Press Cancel if you changed your mind and don't want to record after all.



Loop

If the Loop checkmark is checked playback of samples or sample parts will be looped.

Toolbar Commands
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Reset Samplerate

The Reset Samplerate button resets the samplerate to its original value. This is useful 
when you have been playing around with the samplerate scrollbar and want the original 
samplerate back.

Toolbar Commands
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Samplerate Scrollbar

The Samplerate Scrollbar lets you play your sample at different samplerates. The higher
the samplerate the faster your sample will play. Normally when you move the 
samplerate scrollbar the sample will be played immediately. If you don't like this, you 
can turn this off in the Options dialog box. (Select File | Options).
If you save your sample the current samplerate will be saved in its header. If you want 
to save the sample with the original samplerate, press the Reset Samplerate button 
first.

Toolbar Commands
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Edit Mode

These radio buttons select if your edit actions operate on both channels of a sample, on
only the left channel or only the right channel. Note that these radio buttons are disabled
if the currently active sample is mono. 
Editing individual channels of a stereo sample is only possible if the operation you want 
to perform does not modify the length of the sample.

Toolbar Commands
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Making a selection

Selecting part of a sample is done in the standard Windows click and drag method. Just
click on the start of the desired selection with the left mouse button and drag to the end 
of the desired selection with the left mouse button still pressed. Release the button and 
the selection is made.
The selection is show in red and has a yellow marker on each side of it. These markers 
are used to modify the selection. In the status bar you can see the exact positions of 
these markers.
 
Selecting the entire sample can be done by double-clicking the left mouse button in the 
sample window.
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Modifying a selection

The current selection can be modified by moving the yellow markers on each side of the
red selection. Move your mouse pointer on the marker you want to move until it 
changes shape. Then click and drag with the left mouse button to move the marker. 
Releasing the button will update the selection.
This method of modifying the selection makes it possible to make a rough selection first,
then zoom in on each maker separately and modify the selection accurately.
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Zooming

You can zoom in on the sample by clicking and dragging over the sample with the right 
mouse button. The part you drag over will be the new view.
Zooming out is done by clicking on the sample with the right mouse button. 
Using the zoom feature helps you to modify the selection accurately.
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Placing the Paste Marker

When you paste something from the clipboard into a sample, this pasting always occurs
at the paste marker. The paste marker is a red double vertical line. It is normally at the 
start of the sample. You can grab it there and drag it where you want it to be. Just move 
your mouse pointer on it until it changes shape. Then click the left mouse button and 
drag the paste marker along, while holding the left mouse button pressed. When the 
marker is at the desired position, just release the mouse button.

Edit Menu Commands
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Editing individual channels of a stereo sample

NoiseMaster 2.01 allows you to edit individual channels of a stereo sample. When the 
currently active sample is a stereo sample, the Edit Mode radio buttons will be enabled. 
With these radio buttons you can select whether your operations have effect on both 
channels, only the left channel or only the right channel of your sample. Note that when 
you edit only one channel of a stereo sample, you can only use commands that don't 
modify the length of the sample.
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Status Bar

The NoiseMaster 2.01 status bar shows information about the currently active. Click on 
the field in the status bar picture below, to see what they mean.



This field shows the sample type of the currently active sample. It shows whether the 
sample is mono or stereo, 8 bits or 16 bits and signed or unsigned.



This field shows the size and length of the sample. The size is specified in bytes and the
length in seconds.



This field shows the position and size of the current selection, if there is one. The 
positions and sizes are shown in bytes, samples or seconds depending on what you 
have selected in the Options dialog.



Registering NoiseMaster 2.01

NoiseMaster 2.01 is shareware. It is NOT free. You can try it out for one month, but after
this month you have to either register or destroy your copy. When you register you will 
get the latest version of NoiseMaster without the Registration Reminder at startup. The 
registered version includes high pass, low pass, band pass and band reject filters and 
has two different frequency power spectrum analysis functions : power spectrum and 
power spectrogram.
 
How to register ?
 
First fill in the registration form. Either print it from here (choose the registration form link
and then select File | Print Topic) or print the file REGFORM.TXT and fill it in. You can 
also open the file REGFORM.TXT in you favourite text-editor and fill it in this way.
Don't hesitate to report any possible bugs you found or suggestions you have. 
 
If you can be reached via Email, please fill in you Email address. It is possible to receive
your registered version and the update by Email in uuencoded form. This saves me a lot
of money and time and you will have your copy much sooner. If you want this, fill in YES
after the "Receive update by Email ?" question and Email me, the author, that you 
registration is on the way. I will Email you the update as soon as I receive your money 
and registration form.
 
Registering NoiseMaster costs 25 US dollars or 40 dutch guilders. Send this amount in 
cash (no coins), together with the registration form, to the address below. I cannot 
accept foreign cheques (cashing them costs too much money). Dutch cheques 
(girobetaalkaart) and Eurocheques are ok, but be sure to fill in the amount in dutch 
guilders (f 40,-), not in US dollars.
 
The address is :
 

New Noise
P.O. Box 6092 
2702 AB Zoetermeer
Holland
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New Noise
P.O. Box 6092
2702 AB Zoetermeer
Holland



Thanks and greetings

I want to thank the following people for their useful suggestions and their assistance in 
testing beta versions of NoiseMaster 2.0 :

Max van der Ploeg
Mats Astrom
Ido Ilan Amin
Michael Neary
Anuj Dev

Greetings to :

Fran
Jeroen Koomen (SoniX)
Marcel v/d Lem (SoniX)
Eric Oostendorp (UltraForce)
Pybe Faber
Ad de Vries
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Registration Form

Name :
 
Address :
 
City :
 
Country :
 
Email :
 
Receive updates by Email ? :
 
 
CPU (e.g. 386DX40) :
 
Soundcard :
 
 
NoiseMaster version you have :
 
Bugs found :
 
 
 
 
Suggestions :



Alwin Hoogerdijk
alwin@kgs.twi.tudelft.nl




